
Red Expert
Version 2025.07

User Guide



Table of Contents
1 Introduction 4

2 Install and update 5
2.1 Install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2 Update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.2.1 Skip version . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

3 GUI Overview 7
3.1 Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
3.2 Connection tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
3.3 Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

4 Database 10
4.1 Creating a connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

4.1.1 SSH tunnel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
4.1.2 Certificate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
4.1.3 Extended connection parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
4.1.4 Connect to other servers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

4.2 Create database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
4.2.1 Execute SQL script from file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

4.3 Import connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
4.4 Export connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
4.5 Backup and restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

5 Compare databases module 18

6 Export metadata 19

7 Tools 22

8 Query editor 23
8.1 Parameterised queries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
8.2 Query history . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

9 ER-diagram editor 26

10 Database statistic 27
10.1 Comparing statistics of two databases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

11 Trace manager 31
11.1 Grid view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
11.2 Trace analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
11.3 Session Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

12 User manager 35

13 Grant manager 37

14 Profiler 38

15 Table validation 41

16 Import data 42

2



User Guide
TABLE OF CONTENTS

17 Data generator 44

18 System 45
18.1 Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
18.2 Application log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
18.3 Heap memory status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
18.4 Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

18.4.1 Portability of settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Appendix A Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

A.1 Query editor toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
A.2 ER-diagram editor toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Appendix B Description of parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
B.1 Database connection parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
B.2 Extended database connection parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
B.3 Parameters for adding a driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
B.4 Trace manager configuration file settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
B.5 Trace manager events table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
B.6 Trace analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
B.7 Database statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

B.7.1 Statistics of data pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
B.7.2 Index statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
B.7.3 Tablespace statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Appendix C Application settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
C.1 General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
C.2 Display settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
C.3 Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
C.4 SQL templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
C.5 Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
C.6 Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
C.7 Result set table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

C.7.1 Datetime templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
C.8 Tool bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
C.9 Fonts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
C.10 Colours . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

3



User Guide

Chapter 1

Introduction
Red Expert is a GUI shell developed in Java that provides an interface to Firebird and Red Database.

Red Expert is an operating system independent programme that requires only JDK at least 21.
Red Expert provides easy interaction with the database, allowing you to perform various actions: write

and profile queries, create and edit tables, export and compare database metadata, collect statistics, and
much more.

You can contact us via the feedback form in the application (Help → Feedback) or by sending an e-mail
to rdb.support@red-soft.ru. In your letter you can give us your feedback about the work of the programme,
inform us about a bug or suggest a new functionality. We will be glad to help you!
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Chapter 2

Install and update
2.1 Install

1. Download the Red Expert distribution from the official Red Database DBMS site. The download
is available only to the authorised user.

2. Start the installation RedExpert-<version>-linux-x86_64.bin file on Linux or
RedExpert-<version>-windows-x86_64.exe on Windows. The installation is performed us-
ing the standard software installation wizard. Installation in Russian, English and Portuguese is
provided. After installation, the application icon will appear on the desktop.

3. Run Red Expert.
The Java supplied with Red Expert is used by default. When upgrading from older versions of Red-

Expert (2025.05 and below), Java will be downloaded automatically.
To use third-party Java, you need to specify it in RedExpert/config/launcher.conf. You must use an

absolute path to the executable file, for example:
• Example for Windows:

app.java.path=C:\ProgramFiles\openjdk-21\bin\java.exe

• Example for Linux:

app.java.path=/usr/lib/jvm/openjdk-21/bin/java

You can run the application from the console as java -jar RedExpert.jar command from the directory
where RedExpert.jar is located, You can also launch the Launcher by running the command ./RedExpert64.
When starting the Launcher, you can specify JVM arguments, for example:

./RedExpert64 -Djna.debug_load=true

Also JVM arguments can be specified in RedExpert/config/launcher.conf:

# ---------------------
# - JVM CONFIGURATION -
# ---------------------
-Djna.debug_load=true # as example

2.2 Update
1. When a new version of the application is released, a dialog box will appear to notify you that a

new version has been released, and the status bar will display the message Update available.
2. Click the Download button in the dialog box or the status bar and start the update.
3. When the update is complete, restart Red Expert.
You can also check for updates via menu item Help → Check for updates.

5
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2.2 Update

2.2.1 Skip version
The Skip Version button keeps application at the current version and disables notifications of available

update. In this case, there will be no update notifications until the next version is released. You can install
the skipped version via menu item Help → Check for updates.

You can postpone the update by clicking the Remind Later button. Then the dialog box informing
you about the available update will open again at the next application start.
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Chapter 3

GUI Overview
The application interface is divided into three parts: toolbar, connection tree and workspace.

Img 3.1 — Application interface

1. Toolbar;
2. Connection tree;
3. Workspace.
The status bar at the bottom of the application displays information about the number of connections,

available updates, JDK version and memory status.

3.1 Toolbar
The toolbar contains buttons that allow you to perform various actions, such as connecting to database

and disconnecting from it, creating a new database or connection. There are also buttons for quick access
to tools.

Img 3.2 — Toolbar

The set of buttons on the toolbar can be edited in the View menu or in the application settings.
See appendix for a detailed description of buttons Toolbar.
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3.2 Connection tree

3.2 Connection tree
After connecting to the database, the panel displays the tree structure, the nodes of which represent

database objects. The number of objects of each type is indicated in brackets.

Img 3.3 — Connection tree

A right-click on a node will bring up a pop-up menu with available actions for this object.
Double-clicking on object will open a tab with detailed information about it.

3.3 Workspace
This area is used to work with database tools and edit objects.
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3.3 Workspace

Img 3.4 — Workspace

Detailed information about the object is viewed in the workspace, for example:

Img 3.5 — Information about table

By default, 30 records are loaded at once (this number can be changed in the settings), and the Fetch
All button loads all table data.
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Chapter 4

Database
Tools for creating a database, connecting to it, and extracting and comparing metadata are under the

Database tab.

Img 4.1 — Database tab

4.1 Creating a connection
Red Expert allows multiple database connections to be used simultaneously. The Database Browser

displays information about the connection.

Img 4.2 — Database Browser

To create a connection, select the corresponding item in the Database menu or click the New Connection
button in toolbar. Fill in the fields in the opened window and click the Connect button.
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4.1 Creating a connection

A network connection encryption error may occur when trying to connect. To support encryption
you need Java version at least 21 or Java Cryptography Extension (JCE) add-on installed. Otherwise,
change the value of the WireCrypt = Disabled parameter in firebird.conf.

4.1.1 SSH tunnel
You can connect to the database via an SSH tunnel. As with any SSH connection, all traffic between

you and the database will be encrypted. To do this, fill in the parameters for the SSH connection.

Img 4.3 — SSH tunnel

4.1.2 Certificate
For authentication by certificate, you must fill out the following form:

Img 4.4 — Certificate

4.1.3 Extended connection parameters
Additional connection properties can be set using the Extended tab. On this tab you can see a table

with two columns. The left one corresponds to the connection parameter and the right one to its value.
Refer to the JDBC driver documentation to find out what additional database connection parameters can
be set.

You can also select the transaction isolation level. Different levels of transaction isolation determine
the behaviour of the client application, running this transaction, in relation to other concurrent processes,
running on any computer on the local network, simultaneously reading or modifying the same database
as the current process. For Red Database and Firebird the default is READ_COMMITED. For detailed
description of extended connection parameters see section Extended database connection parameters.
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4.1 Creating a connection

4.1.4 Connect to other servers
Red Expert allows to connect to other servers (not Firebird or RedDatabase). To establish such a

connection do the following:
1. Add driver for working with specified DBMS using menu System → Drivers → Add Driver button.

In the opened window fill in all fields and click Save button.

Img 4.5 — Adding InterBase driver

2. Create a connection using menu Database → Create Connection. In opened tab select correct
JDBC driver and Server, fill in all fields and press Connect button:

12
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4.2 Create database

Img 4.6 — Connect to InterBase database

Currently, such connections are supported only by Query Editor and Execute SQL script from file
tool.

4.2 Create database
To create a database, select the corresponding item in the Database menu or click the Create Database

button in the toolbar. Fill in the fields in the opened window and click the Create button. For a detailed
description of the fields, see the section Database connection parameters.

Img 4.7 — Database creation

When trying to create a database, a network connection encryption error may occur. To support
encryption you need Java version at least 21 or JCE add-on installed. Otherwise, change the value of
the WireCrypt = Disabled parameter in firebird.conf.
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4.3 Import connection

4.2.1 Execute SQL script from file
Select an open connection and specify the path to the file with SQL script and press the Execute SQL

script button. Make a commit or rollback transaction by clicking on the corresponding buttons.

Img 4.8 — Execute SQL script from file

4.3 Import connection
If you already have connections configured in IBExpert, there is an option to import connections.

Start Red Expert and connect to the required user database. Select the menu item Database → Import
connections → Import from DB and select the required connection in the opened window.

Img 4.9 — Import connection from database

Importing a connection from a file is also available:
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4.4 Export connection

Img 4.10 — Import connection from file

4.4 Export connection
For exporting a connection to a file, select the menu item Database → Export connections and select

the required connection in the opened window.
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4.5 Backup and restore

Img 4.11 — Export connection

4.5 Backup and restore
To perform a backup or restore, select the menu item Database → Backup and Restore.
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4.5 Backup and restore

Img 4.12 — Backup options Restore options

Backup options correspond to gbak keys:
• Ignore checksums - gbak -ignore;
• Metadata only - gbak -meta_data;
• No garbage collection - gbak -garbage_collect;
• Non-transoortable backup - gbak -nt.

Img 4.13 — Restore options

Restore options also correspond to gbak keys:
• Overwrite database file - gbak-replace_database;
• Deactivate indexes - gbak -inactive;
• Metadata only - gbak -meta_data;
• No shadow - gbak -kill;
• No validity check - gbak -no_validity;
• Restore one at time - gbak -one_at_a_time.
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Chapter 5

Compare databases module
The tool compares two databases and generates a SQL script to make them identical.

As a result of executing the generated SQL script, the selected databases will have identical struc-
ture, but not identical data.

Img 5.1 — Compare databases module

Source database - the database to the state of which the target database is to be brought to. Target
database - the database to which the changes will be applied.

The Attributes block is a list of database elements that need/ do not need to be considered in the
comparison.

The Parameters block is a list of conditions that affect comparing databases and forming an SQL script
that brings target database structure to state of source database:

• Check for CREATE/ALTER/DROP - add to SQL script queries for creating/modifying/deleting
objects in target database;

• Ignore comments - consider comments when comparing databases;
• Ignore calculated fields - consider calculated fields when comparing databases;
• Ignore fields positions - consider column positions when comparing databases;
• Ignore PK/FK/UK/CK - consider constraints when comparing databases.

Found differences will be recorded in the Output tab. In SQL tab will be script that brings the structure
of the target database to structure of source database.
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Chapter 6

Export metadata
This tool extracts metadata of selected database into SQL script, execution of which allows you to

create a duplicate of that database.

Img 6.1 — Export metadata

Source database is the database whose metadata needs to be extracted.
The Attributes block is a list of database elements that need/ do not need to be considered when

exporting.
The Parameters block is a list of conditions that affect the extraction of metadata and the generation

of the SQL script that creates the selected database:
• Ignore comments - consider comments when exporting;
• Ignore calculated fields - consider calculated fields when exporting;
• Ignore PK/FK/UK/CK - consider restrictions when exporting.

You can view results of metadata export in Output, View, and SQL tabs.
Output tab lists the items whose metadata has been extracted:
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Img 6.2 — Output tab

View tab displays the extracted items that will be created when the generated script is executed:

Img 6.3 — View tab

SQL tab contains the generated SQL script:
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Img 6.4 — SQL tab
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Chapter 7

Tools
This tab contains various tools for working with database.

Img 7.1 — Tools tab

Available tools:
• Query editor
• ER-diagram editor
• Database statistic
• Trace manager
• User manager
• Grant manager
• Profiler
• Table validation
• Import data
• Data generator
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Chapter 8

Query editor
Query Editor is a customisable tool for viewing and executing SQL statements. Any number of editors

can be open at the same time.
Query Editor supports the following functions:

• Customisable SQL syntax highlighting;
• Tooltips for keywords and database object names;
• Execution of multiple queries;
• Executing and displaying multiple queries with multiple results (Result Set);
• Output contains information about how table counter values have changed during query execution;
• Support for parameterised queries;
• Full printing support;
• Transaction management;
• IDE style text editor functions - search, replace, paste, etc.;
• Export results;
• Support for multiple open connections;
• Searchable executable history of SQL queries;
• Fast transition from editor to database object view by pressing CTRL + Left mouse button on the

object name;
• Transaction isolation level selection.
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8.1 Parameterised queries

Img 8.1 — Query editor

8.1 Parameterised queries
In some cases, you need to create a query that can be used multiple times, but with different input

values each time. For example, you can write several queries to find data about an employee with a certain
last name. Or you can write a single query, changing only the employee's last name.

To create a query that may have different input data at different times, query parameters are used.
Parameters can be named or unnamed. An unnamed parameter is a question mark (?) that can be specified
anywhere in the query, instead of a literal value. For example:

SELECT * FROM employee WHERE (last_name = ?)

After running such query, a dialogue window will open for entering the parameter value (employee's
last name):
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8.2 Query history

Img 8.2 — Unnamed parameter

Named parameters are a combination of a colon and the parameter name (:<paramname>), which
can also be substituted for a literal value. Named parameters are especially useful if there are multiple
parameters in a query. For example:

SELECT * FROM employee WHERE (last_name = :surname AND first_name =:name)

After running such query, a dialogue box will open for entering the values of the parameters (last name
and first name of the employee):

Img 8.3 — Named parameters

8.2 Query history
After successful execution, the query is stored in the editor's log cache. The number of queries stored

in the history is specified in the editor settings. Saved queries are not lost after restarting the application or
the query editor.
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Chapter 9

ER-diagram editor
Tool is used to create and edit ER-diagrams of databases.

Img 9.1 — ER-diagrams editor

Main functions:
• Creating and editing an ER-diagram;
• Generating an SQL script to create the tables represented in the diagram;
• Building an ER diagram from an existing database;
• Exporting the diagram to various formats.
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Chapter 10

Database statistic
Tool displays database statistics and also allows you to compare the results of analysing two databases.

Img 10.1 — Database statistic

Statistical collection formats:
• Default - analysis of the whole database, output is similar to execution of gstat without options;
• Tables - data page statistics, output is similar to gstat -data;
• Indices - analyses indexes, output similar to gstat -index;
• Record Versions - adds statistics on average record lengths, number of versions and information

about BLOB;
• System Objects - analyses system tables and indexes;
• Header page - static database data, output is similar to gstat -header;
• Only selected tables - analysis of selected tables, the parameter is available if a connection to the

selected database is established.
Statistic is displayed in a separate tab:
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10.1 Comparing statistics of two databases

Img 10.2 — Statistics

See Database statistics for a detailed description of the values to be collected.

10.1 Comparing statistics of two databases
For comparing the statistics of two databases, collect statistics for the second database and click the

Compare button.
The Text tab will display text output of statistics:
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10.1 Comparing statistics of two databases

Img 10.3 — Textual output of statistics

In Tables, Indices and Tablespaces tabs, column values show difference between result of first and
second database.
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10.1 Comparing statistics of two databases

Img 10.4 — Result of statistics comparison

Green colour indicates what is in both databases. Red colour indicates tables and indexes that are
present in the first database but absent in the second database.
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Chapter 11

Trace manager
Trace Manager allows you monitor and analyse everything that happens in the database in real time.

It tracks and logs such events as: connection to database and disconnection from it, database creation and
deletion, execution of DML and DDL, stored procedures, etc.

Img 11.1 — Trace manager

To enable audit service, all fields must be filled in. You can select a saved database connection and
the parameter fields will be filled in automatically based on that connection.

Specify a configuration file with audit settings. Depending on the server version, the audit settings
differ slightly, so select the server corresponding to the database from the drop-down list. If the required
configuration file is not available, configure the audit settings and save them to a configuration file. For a
description of the parameters, see. Trace manager configuration file settings.

11.1 Grid view
Event table in Trace Manager is filled in either when tracing is enabled or when a saved log file is

opened. When opening a log file, there is an option to select the encoding.
By default, the event table displays all possible columns containing information about the registered

event. Some columns can be hidden. To do this, click the Visible columns button and modify them as
required.
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11.2 Trace analysis

Img 11.2 — Grid view

When you right-click on any table, a context menu appears to export the table.
See Trace manager events table for a description of the event table columns.

11.2 Trace analysis
Trace analysis displays information about events that occurred during a defined time interval. Events

are added either when tracing is enabled or when a log file is opened.
Trace analysis parameters:

• TIME - Information about query execution time;
• READ - Information about number of pages read from the disc;
• FETCH - Information about number of pages read from page cache;
• WRITE - Information about number of pages recorded on the disc;
• MARK - Information about number of pages changed in the page cache;
• RSORT - Information about RAM size used for sorting;
• DSORT - Information about the size of temporary files used in the query;
• Rround values - If the value is greater than 10000, it will be converted to a larger unit until it

becomes less than 10000;
• Show Plan - Execution plan for query.

Additional parameters:
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11.3 Session Manager

• Period - Time period to be analysed; after changing the period, press the Rebuild button;
• Compare queries by N symbols - Consider queries as identical if they have the same first N char-

acters;
• Filter events - Allows you to select the types of events to be analysed.

Img 11.3 — Result table

When you hover over a cell, a tooltip will show the sum of the column values and the average value. To
view the full text of the query and its plan, you need to select the cell. Double-clicking will open a window
with the event record in text format.

See Trace analysis for description of columns of the resulting event table.

11.3 Session Manager
The Session Manager displays a list of all currently available trace sessions. The manager tab is visible

only when the current audit session is running.
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11.3 Session Manager

Img 11.4 — Session Manager

In the window on the left, you can select the name of the session and see information about it (ID,
starting user, start time), and stop the tracing session.
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Chapter 12

User manager
With the User Manager you can manage database users: add, edit and delete.

Img 12.1 — User manager

To add, edit or delete user, you should press the corresponding button and fill in all the fields in the
opened window.
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Img 12.2 — Adding user
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Chapter 13

Grant manager
Grant manager displays privileges and allows you to manage them.

Img 13.1 — Grant manager
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Chapter 14

Profiler
Profiler allows you to measure the performance and execution cost of SQL and PSQL code.

Img 14.1 — Profiler

1. Select the connection of interest from the drop-down list.
2. Click the Select button and in the window that opens, select the user connection to be profiled:

Img 14.2 — Selecting a user connection to profile

You can also open a saved profiler session by clicking the Load button:
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Img 14.3 — Saved Sessions

Formats for displaying the result:
• Compact view - Displays an overall view of query execution. Repeating processes within a common

parent will be merged into one. This is the default value.
• Display access data - Displays/hides the plan for executing the request. Enabled by default.
• Round values - If the total or average time is greater than 1000000ns, it will be converted to a

larger unit until the value is less than 1000000ns. Enabled by default.
Cancel All Sessions button cancels all profiling sessions for the selected connection (with the specified

ATTACHMENT_ID).
In compact view, for each non-last node (except for ROOT NODE - the root node) there is a node

Total time, which shows the time spent without taking into account child processes.
In result table displays information collected by the profiler, viz:

• Process name or SQL code;
• Time per process in nanoseconds (including child processes) and the percentage of time from the

parent process;
• Average time per process in nanoseconds (including child processes) for repetitive processes com-

bined into one node;
• Number of calls of the recurring processes.

При двойном клике по узлу откроется окно просмотра данных:
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Img 14.4 — Data view

A Profiler session can be run for a single query from the Query Editor by clicking the Run in Profiler
button. In this case the following will be executed:

1. Starts profiler session.
2. Query in the editor will be executed.
3. Profiler session will finish.
4. Displays profiler panel with the collected information.
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Chapter 15

Table validation
Database validation allows you to perform low-level consistency checks for data on disc.
Online validation can do following:

• validate some (or all) user tables in the database; system tables are not validated;
• validate some (or all) indexes;

This tool performs online table validation only. Other ODS validations such as Header, PIP, TIP,
Generators pages are not performed.

Img 15.1 — Table validation
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Chapter 16

Import data
This tool is used to import data from a file into a table. Import from XLSX, XML and CSV files is

supported.

Img 16.1 — Import data

Data import parmeters:
• Import from the connection - Allows to select the database as source.
• Data file - Path to data source file. Import from XLSX, XML and CSV files is supported.
• Blob file - Path to source file with blobs (with .lob extension).
• Target connection - Database the import will be performed to.
• Target table - Table the import will be performed to.
• Separator - Type of data separator in CSV files.
• Page number - For XLSX files allows to select the page of excel-file to import data from.
• First row - Row starting from which data will be imported.
• Last row - The row after which data import will be stopped. Rows that do not fall in the range

between the first and last imported row will be ignored.
• Commit step - The number of records after which the transaction will be commited and data will

be saved in the table.
• Erase table before import - Defines if target table should be cleared of data that was in it before
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import.
• Source column - Column name from which data should be imported. The Correlate button auto-

matically assigns the imported columns to the target columns by their names.
• Properties - Import BLOB as a file or as text.

Img 16.2 — Example of filling in fields for import
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Chapter 17

Data generator
Data Generator tool is intended for quick and convenient filling of table fields with a large amount of

data.

Img 17.1 — Data generator

Select a table. Fields and their types will be displayed. Choose checkbox for the field if you want to
generate data for it. Otherwise this field will be filled with NULL values.

Specify number of records to be generated. Generating large amounts of data may take some time.
In Commit after field, enter the number of rows after insertion that will commit.
Errors may occur during generation. By default, they are not written to log file. Tick the corresponding

checkbox so that all errors are recorded in the log.
If errors occur during the generation process for some records (e.g. due to column constraints), the

generator continues by default. This behaviour can be changed by ticking the Stop on error checkbox.
Method of generation can be selected for each field of the table:

• Random - Depending on the field type, different generation parameters are configured.
• Get from another table - In this method you need to select a table, column and number of records.

The records from the table are selected randomly in the specified number, then the main table is
filled from this list of values.

• Get from list - The values of the list form the content of the field. The list must consist of elements
of the corresponding data type. The delimiter can be any single character or escape-sequence
starting with a backslash (\). The list itself can be entered manually in the field provided for this
purpose, or loaded from a file.

• Autoincrement - For auto increment the initial value, step and direction of step movement (up or
down) are configured.
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Chapter 18

System
18.1 Drivers

Drivers pane lists all installed JDBC drivers.
Libraries Jaybird 3 Driver, Jaybird 4 Driver, Jaybird 5 Driver are installed in Red Expert by default,

that allows to work with Firebird and Red Database.

Img 18.1 — Drivers

To add a new driver, click on Add Driver button and fill in all fields. See Parameters for adding a
driver section for detailed description of the fields.

Img 18.2 — Adding driver
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18.2 Application log

18.2 Application log
Log records all information that is output to the standard output stream, errors and warnings. Output

level can be set in Settings to limit the information contained in the log.
System output log is stored in $HOME/.redexpert/logs. and can be opened with any text editor, but

can also be viewed with Redexpert.

18.3 Heap memory status
Red Expert allows monitoring current memory usage and running gubbish collection.

Img 18.3 — Heap memory status

18.4 Preferences
Select System → Preferences menu item to configure the application.

Almost all changes take effect when Red Expert is restarted.
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18.4 Preferences

Img 18.4 — Preferences

See Application settings appendix for a detailed description of settings.

18.4.1 Portability of settings
To store Red Expert and its settings in the same folder, follow the steps below:
1. Close the programme;
2. Open .../Red Expert/config/launcher.conf file;
3. For the app.settings.directory parameter, specify the value ../.redexpert and save the changes;
4. In the explorer address bar, enter the path %homepath%;
5. Move the .redexpert folder to the root of the directory where Red Expert is installed;
6. Run Red Expert.
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Appendix A Toolbar
Description of each toolbar and its associated buttons and actions is provided below.

Table A.1 — Toolbar

Description Shortcuts

Hide/display the connection tree.

Connection to selected database.

Connect to all databases that are added to the connec-
tion tree.

Refresh all objects in current connection.

Search object in connection tree in established connec-
tion.

Ctrl + F

Create new connection. Ctrl + Shift + N

Create database.

Execute SQL script from file.

Open a database metadata comparison tool.

Open tool for extracting metadata into a script.

Open query editor.

Open ER diagram editor.

Open database statistics collection tool.

Open trace manager.

Open user manager.

Open grant manager.

Open profiler.

(table breaks)
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A.1 Query editor toolbar

(table breaks)

Description Shortcuts

Open table validation tool.

Open data import tool.

Open test data generator.

Open system console.

View system log.

Open application settings.

Open documentation.

A.1 Query editor toolbar

Table A.2 — Query editor toolbar

Description Shortcuts

Execute SQL script. F9

Execute script in one query. F5

Execute SQL script in the profiler. Shift + F5

Stop execution of query.

Commit transaction. Ctrl + Shift + Q

Rollback transaction. Ctrl + Shift + R

Switch on autocommit mode.

Stop execution of SQL script when an error occurs.

Export query result to file.

(table breaks)
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A.2 ER-diagram editor toolbar

(table breaks)

Description Shortcuts

Limit number of input rows.

Managing query bookmarks. Ctrl + B

Open query execution history. Ctrl + Shift + H

Enter previously executed query in editor. Ctrl + Shift + Down

Enter next query in editor. Ctrl + Shift + Up

Export selected dataset to file.

Show metadata of current result set.

Add filters for current result set.

Show query plan. Ctrl + Shift + P

Show transaction parameters.

Display results output panel. Ctrl + E

Change separator orientation. Ctrl + Alt + Q

A.2 ER-diagram editor toolbar

Table A.3 — ER-diagram editor toolbar

Description Shortcuts

Create table.

Delete selected object.

Add relation.

Delete relation between selected objects.

(table breaks)
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A.2 ER-diagram editor toolbar

(table breaks)

Description Shortcuts

Generate SQL script to create objects from diagram.

Build ER-diagram of existing database.

Add text block.

Add header for diagram.

Open font settings.

Open line settings.

Change colour of selected object.

Change background colour of diagram.

Zoom out.

Zoom in.
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Appendix B Description of parameters

B.1 Database connection parameters

Table B.1 — Database connection parameters

Parameter Description

JDBC driver Select JDBC driver from the drop-down list to create a new database.
For Red Database and Firebird JDBC driver Jaybird 3 is recom-
mended.

Connection name Database connection name

Server name Database server host or IP address

Port Port for database connection

Database file Path to database file or alias

Username Username of user in whose name the database will be created

Password User password

Save password Should password be saved for connecting to database

Encrypt password Should password be stored in encrypted form

Encoding Specifies default character set for string (character) values of the
entire database.

Page size Size of the database page in bytes. Valid values are 4096, 8192 and
16384.

B.2 Extended database connection parameters
This table lists some parameters for the Jaybird 3 driver:

Table B.2 — Extended database connection parameters

Parameter Type Description

isc_dpb_user_name string Name of the connecting user.

isc_dpb_password string User Password.

isc_dpb_sql_role_name string Role

isc_dpb_sql_dialect byte SQL dialect.

isc_dpb_process_id int Process ID.

isc_dpb_process_name string Process name.

isc_dpb_lc_ctype string Connection character encoding. This parameter
tells database server what encoding should be
used to send string values to client.

isc_dpb_connect_timeout int Connection timeout (in seconds).

isc_dpb_gss - Use trusted authentication Gss.

isc_dpb_num_buffers int Number of database pages to be cached.

isc_dpb_set_db_readonly boolean Set database to read-only mode.

(table breaks)
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(table breaks)

Parameter Type Description

isc_dpb_set_db_charset string Set character set for the database.

isc_dpb_trusted_auth - Informing that trusted authentication will be
used.

isc_dpb_multi_factor_auth boolean Informing that multifactor authentication will be
used.

isc_dpb_utf8_filename - Informing that file name passed in UTF-8 format.

isc_dpb_certificate string Client certificate alias for multifactor connection.

isc_dpb_verify_server - Flag to verify server certificate (multifactor au-
thentication).

isc_dpb_repository_pin string Pin code for certificate container (multifactor au-
thentication).

isc_dpb_wire_crypt_level string Sets whether to encrypt the network connection.
It can take three possible values: REQUIRED,
ENABLED, DISABLED and DEFAULT. By de-
fault, encryption is enabled (Enabled).

B.3 Parameters for adding a driver

Table B.3 — Parameters for adding a driver

Parameter Description

Driver name Driver name for identification

Description Description of this driver

Database Select DBMS for which this driver is used

JDBC URL The URL address template for this JDBC driver. For example:
jdbc:firebirdsql://[host]:[port]/[source].

Path Path to jar file of JDBC driver

Class name Class name of JDBC driver. Select the search button if the name is
unknown and the system scans the jar file entered in the path field
to find the driver class name

B.4 Trace manager configuration file settings

Table B.4 — Trace manager configuration file settings

Parameter Description

log_security_incidents Server security events (security incidents)

log_initfini/log_init Events of start/stop of database logging

log_connections Events of connection/disconnection to database

log_transactions Transaction start and completion events

log_statement_prepare Database query preparation events

(table breaks)
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(table breaks)

Parameter Description

log_statement_free Database query release events

log_statement_start Events of start execution of queries to database

log_statement_finish Events of finish execution of queries to database

log_procedure_start Events of start execution stored procedures

log_procedure_finish Events of finish execution stored procedures

log_function_start Events of start execution stored function

log_function_finish Events of finish execution stored function

log_trigger_start Trigger execution start events

log_trigger_finish Trigger execution finish events

log_context Events of context variable value changes

log_errors Error logging

log_warnings Warning logging

print_plan Print query plans

print_perf Print query execution statistics

log_blr_requests Direct execution events of compiled queries in internal server view -
BLR

print_blr Content of BLR requests will be converted to text representation,
otherwise it will remain in binary form

log_dyn_requests Events of direct execution of compiled metadata change queries
(DDL) in the internal server view - DYN

print_dyn Content of DYN queries will be converted to text representation,
otherwise it will remain in binary form

log_privilege_changes Privilege change events

log_changes_only Recording only those events that changed data in the database

print_stack_trace Print stack of server function calls when an error event is terminated

log_auth_factors Events of verification authentication factors

log_mandatory_access Mandate access audit

log_record_mandatory_access Events about mandate access to records

log_object_relabeling Events of object label change

log_record_relabeling Events of record label change

log_services Connection/disconnection and service start events

log_service_query Events of service queries

include_user_filter Regular expression to which the user name must match

exclude_user_filter Connections from users matching this regular expression will not be
logged

include_process_filter Regular expression to be matched by the name of the user process

exclude_process_filter Connections from processes that match this regular expression will
not be logged

(table breaks)
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(table breaks)

Parameter Description

include_filter Regular expression in SQL syntax (SIMILAR TO), which must be
matched by the text of SQL query.

exclude_filter Regular expression in SQL syntax (SIMILAR TO), which must not
be matched by the text of SQL query.

connection_id Connection identifie on server that will be monitored

log_filename Log file name

max_log_size Maximum size of log files in megabytes. A value of 0 means unlimited
size

time_threshold Events whose execution time is less than specified time (in ms) will
not be logged

max_sql_length Maximum length of one SQL query record in log file, in bytes

max_blr_length Maximum length of BLR query to be logged, in bytes

max_dyn_length Maximum length of DYN-query to be logged, in bytes

max_arg_length Maximum length of one query/procedure parameter in log file

max_arg_count Maximum number of query/procedure parameters to be logged

B.5 Trace manager events table
Description of each column in events table is given below:

Table B.5 — Description of events table columns

Parameter Description

NUM Row number

TSTAMP Time and date of event

ID_PROCESS Process ID

ID_THREAD Thread ID

EVENT_TYPE Event type

FAILED In case of unsuccessful or unauthorised attempt to exe-
cute query, the result FAILED or UNAUTHORIZED is
logged

ID_SESSION Session ID

NAME_SESSION Session name

ID_SERVICE Service ID

USERNAME Username

PROTOCOL_CONNECTION Connection protocol

CLIENT_ADDRESS IP address or computer name

TYPE_QUERY_SERVICE Service query type

OPTIONS_START_SERVICE Options passed to service manager from client at start

ROLE User role

(table breaks)
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(table breaks)

Parameter Description

DATABASE Database name

CHARSET Encoding

ID_CONNECTION Connection ID

CLIENT_PROCESS Client process

ID_CLIENT_PROCESS Client process ID

ID_TRANSACTION Transaction ID

LEVEL_ISOLATION Isolation level

MODE_OF_BLOCK Lock mode (WAIT or NO WAIT)

MODE_OF_ACCESS Access mode

TIME_EXECUTION Execution time (in ms)

COUNT_READS Number of pages read from the disc

COUNT_WRITES Number of pages written to disc

COUNT_FETCHES Number of pages fetched from page cache

COUNT_MARKS Number of pages modified in page cache

ID_STATEMENT Query ID

RECORDS_FETCHED Number of fetched records

STATEMENT_TEXT Query content

PARAMETERS_TEXT Query execution parameters

PLAN_TEXT Query plan

TABLE_COUNTERS Table counters

DECLARE_CONTEXT_VARIABLES Name and value of context variable

EXECUTOR Users, roles and database objects for which privileges
have been granted

GRANTOR User who grants privileges

PRIVILEGE Assigned/revoked privilege

PRIVILEGE_OBJECT Object for which the privilege is granted (revoked)

PRIVILEGE_USERNAME User assigned the privilege

PRIVILEGE_ATTACHMENT Connection ID

PRIVILEGE_TRANSACTION Transaction ID

PROCEDURE_NAME Procedure name

RETURN_VALUE Return values of procedure

TRIGGER_INFO <trigger_name> [FOR <table_name>] (ON
<database event> | {BEFORE | AFTER} <table
event or DDL event>)

SENT_DATA Data passed to service manager

RECEIVED_DATA Data received by service manager

ERROR_MESSAGE Error message text

OLDEST_INTERESTING Number of oldest interested transaction

(table breaks)
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(table breaks)

Parameter Description

OLDEST_ACTIVE Oldest active transaction number

OLDEST_SNAPSHOT Number of transaction that was active at the time the
OAT transaction was started

NEXT_TRANSACTION Next transaction number

SORT_MEMORY_USAGE_TOTAL Total cache size (in bytes) allocated during the sorting
process

SORT_MEMORY_USAGE_CACHED RAM cache size (in bytes) allocated during the sorting
process

SORT_MEMORY_USAGE_ON_DISK Disc cache size

B.6 Trace analysis
Description of resulting table columns:

Table B.6 — Description of resulting table columns:

Parameter Description

QUERY Query text

COUNT Query execution count

PLAN_COUNT Query plan count

TOTAL_TIME Total execution time in milliseconds

MIN_TIME Minimum execution time in milliseconds

AVG_TIME Average execution time in milliseconds

MAX_TIME Maximum execution time in milliseconds

STD_DEV_TIME Standard deviation of execution time

TOTAL_READ Total pages read from disc

MIN_READ Minimum number of pages read from disc

AVG_READ Average number of pages read from disc

MAX_READ Maximum number of pages read from disc

STD_DEV_READ Standard deviation of number of pages read from disc

TOTAL_FETCH Total number of pages read from page cache

MIN_FETCH Minimum number of pages read from page cache

AVG_FETCH Average number of pages read from page cache

MAX_FETCH Maximum number of pages read from page cache

STD_DEV_FETCH Standard deviation of number of pages read from page cache

TOTAL_WRITE Total number of pages recorded on disc

MIN_WRITE Minimum number of pages recorded on disc

AVG_WRITE Average number of pages recorded on disc

MAX_WRITE Maximum number of pages recorded on disc

STD_DEV_WRITE Standard deviation of number of pages recorded on disc

(table breaks)
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(table breaks)

Parameter Description

TOTAL_MARK Total number of pages edited in page cache

MIN_MARK Minimum number of pages edited in page cache

AVG_MARK Average number of pages edited in page cache

MAX_MARK Maximum number of pages edited in page cache

STD_DEV_MARK Standard deviation of number of pages edited in page cache

TOTAL_RSORT Total RAM used for sorting (in bytes)

MIN_RSORT Minimum RAM used for sorting (in bytes)

AVG_RSORT Average RAM used for sorting (in bytes)

MAX_RSORT Maximum RAM used for sorting (in bytes)

STD_DEV_RSORT Standard deviation of RAM used for sorting

TOTAL_DSORT Total temporary file size used in query (in bytes)

MIN_DSORT Minimum temporary file size used in query (in bytes)

AVG_DSORT Average size temporary files used in query (in bytes)

MAX_DSORT Maximum temporary file size used in query (in bytes)

STD_DEV_DSORT Standard deviation of temporary file size used in query

B.7 Database statistics
B.7.1 Statistics of data pages

Table B.7 — Statistics of data pages

Parameter Description

name Table name

primary pointer page First page number of indirect pointers to pages storing table
data

index root page Page number, which is first page of index pointers to table
indexes

pointer pages Total indirect pointer pages to pages storing table data

data pages Total pages that store table data. This count includes pages
storing unconfirmed versions of records and garbage because
gstat cannot distinguish them from each other

data page slots Number of database page pointers contained in the pointer
pages. Must be equal to number of data pages

primary pages Number of pages equal to (Data pages - Secondary pages)

secondary pages Number pages on which no primary versions of records are
stored

swept pages Number of pages that have only primary versions of records,
and all of them were created by committed transactions. Such
data pages should be skipped by sweep procedure

(table breaks)
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(table breaks)

Parameter Description

empty pages Number of pages with no records

full pages Number of full pages

big record pages Number of pages that are filled with only one record

blob pages Number of pages with blobs

average record length Average size of a compressed record in bytes

total records Total number of rows in table

average version length Average length of old versions in bytes

total versions Total number of old versions in table

max versions Maximum chain of old versions to be recorded

average fill Histogram of memory usage distribution for all pages allo-
cated in table

total formats Total formats in RDB$FORMATS table

used formats Number of used formats

average fragment length Average fragment size in bytes

total fragments Number of fragments in all records

max fragments Maximum number of fragments per record

average unpacked length Average record size in bytes (not compressed)

compression ratio Ratio of average uncompressed key length (Average prefix
length + Average data length) to average compressed key
length (Average key length).

blobs Number of all blobs (level 0, 1 and 2)

total length Blob size, in bytes

level <n> Number of blobs per level

table size(without blobs) Table size in bytes (data pages * page size). Calculated col-
umn

size with blobs Aggregate size of table data (table size(without blobs) + blobs
total length). Calculated column

size with blob pages (table size(without blobs) + blob pages * page size). Calcu-
lated column

size with indices Aggregate size of table data and aggregate size of all indices
on table. Calculated using following formula:
𝑋 = 𝑆 +

∑︀𝑛
𝑖=0 𝐸𝑖,

S – size with blob pages;
n – number of indexes in table;
E – estimated index size in bytes (estimated full size).

range <percentage full> Number of pages that are filled by specified percentage
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B.7.2 Index statistics

Table B.8 — Index statistics

Parameter Description

name Index name

table name Table name

real selectivity Calculated using following formula: 1 / (nodes - totalDup)

average data length Average length of each key in bytes. This is likely smaller
than actual sum of column sizes because Red Database uses
index compression to reduce the amount of data stored on an
index sheet page

total dup Total number of index duplicate rows

max dup Number of nodes that have the highest number of duplicates.
Will always be zero for unique indices. If the number is large
compared to the number in total dup, it is a sign of low
selectivity

root page Index root page number

depth Number of levels in index tree page. If the depth of the index
page tree exceeds 3, access to records through the index will
not be maximised. To reduce the depth of the index page
tree, increase the page size. If increasing the page size does
not reduce the depth, increase the page size again

leaf buckets Number of the lowest level (leaf) pages in the index tree.
These are pages that contain pointers to records. High-level
pages contain indirect links.

leaf full size Size of the lowest level (leaf) pages in the index tree (leaf
buckets * page size). Calculated column

estimated full size Approximate index size in bytes. Calculated using following
formula:
𝑁 = 𝐿 * (1 + 𝐴

𝑃 )𝐷−1 * 𝑃
N – approximate index size in bytes;
L – number of lowest level pages (leaf pages) in index tree
(leaf buckets);
A – average node size in bytes (average node length);
P – average node size in bytes (average node length);
D – number of levels in index tree page (depth).

nodes Total number of records indexed in the tree. Must be equal
to the number of indexed rows in the tree, although the gstat
report may include nodes that were deleted but not cleaned
up in the garbage collection. May also include multiple items
for records that have had their index key changed

average node length Average node size in bytes

average key length Average key size in bytes including compression. The length
of each key is added 1 to 5 bytes depending on the key size
and prefix. The average key size is then calculated

compression ratio Average key and prefix length in bytes

(table breaks)
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(table breaks)

Parameter Description

average prefix length Average size (in bytes) used by node prefixes

average data length Average length of each key in bytes. This is likely smaller
than the actual sum of column sizes, because Red Database
uses index compression to reduce the amount of data stored
on an index sheet page

clustering factor It is a measure of how much I/O the database would perform
if it had to read every row in the table by index, in index
order. That is, it shows how ordered the rows in the table are
by the index values. If the value is close to the total number of
pages, then the table is very well ordered. In this case, index
entries on the same page of the index sheet usually point to
rows that are in the same data pages. If the value is close to
the total number of rows, then the table is very disordered.
In this case, it is unlikely that index entries on the same page
of the index sheet point to the same data pages

ratio Ratio of Clustering factor to the total number of nodes in the
index

full size Index size in bytes. Calculated by the formula: 𝐿 * (1 +
𝐴
𝑃 )𝐷−1 * 𝑃 ,
L – number of the lowest level pages (leaf pages) in the index
tree (leaf buckets);
A – average node size in bytes (average node length);
P – database page size (page size);
D – number of levels in a page of index tree(depth).

B.7.3 Tablespace statistics

Table B.9 — Tablespace statistics

Parameter Description

name Tablespace name

full path Path to tablespace file

table count Number of tables in the tablespace

index count Number of indexes in tablespace
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Appendix C Application settings

C.1 General

Table C.1 — General settings

Parameter Description

Check for updates at startup If enabled, the application will report new versions.

Load unstable versions Enable/disable the ability to update to an unstable version of the
application.

Prompt to save open documents Ask to save changes before closing the document. If off, changes are
not saved.

Parse procedure and function vari-
ables

Display procedure and function variables when viewing detailed in-
formation about an object

Recent file to store Number of files displayed in the menu item Edit → Recent Files

Recent hosts to store Number of last entered hosts displayed in the drop-down list for se-
lection.

Line separator The character to be used as a delimiter

Default file encoding Default file encoding

Table C.2 — Logging

Parameter Description

Display system console Display/hide system console

Login application operation Log application events to the system log

Log system out to console Output System.out stream to console

Log system errors to console Output System.err stream to console

Maximum rolling log backups Number of log files saved. When the log (system.log) reaches a
size greater than 1MB, the recording continues to a new file (sys-
tem.log.1), etc. When the number of files equals the number specified
in this parameter, the files will be overwritten. If 0 is specified, the
number of files is unlimited.

(table breaks)
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(table breaks)

Parameter Description

Output event log level Level of output to the output status log and the output console:
1. FATAL - captures very serious errors that are

likely to cause the application to stop being
used;

2. ERROR - captures serious errors that need to
be checked but will not terminate the applica-
tion;

3. WARN - captures potentially dangerous situa-
tions;

4. INFO - informs about events of application op-
eration at a high level;

5. DEBUG - informs about events at a lower level
for debugging the application (for developers);

6. TRACE - detailed logging for very low-level de-
bugging;

7. ALL - all of the above levels.
Levels are ordered and each next level incorporates pre-
vious levels.

Path to logs directory Specifies absolute or relative path to the logs directory containing log
files. For example, if the relative path logs is specified, log files will
be created at the path /<path_to_app>/logs.

Table C.3 — Internet proxy settings

Parameter Description

Use proxy server for internet connec-
tions

Use/do not use a proxy server for internet connections

Proxy host Name or IP of proxy server

Proxy port Proxy server port number

Proxy user User name for authorisation on proxy server (if required)

Proxy password User password for authorisation on the proxy server (if required)

C.2 Display settings

Table C.4 — General

Parameter Description

Display splash screen at startup Show/skip splash screen at startup

Maximum window on startup Open application window full screen at startup

Status bar Show/hide status bar

Connections Show/hide connection information window
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Table C.5 — Appearance

Parameter Description

Look and feel Application design

Interface language Application Language

Use anti-aliased fonts Display the font smoothly by blurring corners

C.3 Shortcuts

Table C.6 — Shortcuts

Command Shortcuts Description

Upper case Ctrl + Shift + U Converts the selected text to uppercase

Execute SQL script F9 Executes SQL-script in the query editor

Execute in the profiler Shift + F5 Executes in the profiler the SQL script in the query
editor

Execute single query F5 Execute with a single query the SQL script in the
query editor

Data generator Open test data generator tool

Documentation F1 Open application documentation

Drivers Open the drivers window

Duplicate text up Ctrl + Alt + Up Duplicate the line the cursor is pointing at in the
query editor to the line above it

Duplicate text down Ctrl + Alt + Down Duplicate the line the cursor is pointing to on the
line below in the query editor

Comment text Ctrl + Slash Comment out the current line in the query editor

Replace Ctrl + R Find and replace the specified text

Commit transaction Ctrl + Shift + C Commit transaction

Extract database meta-
data into SQL script

Open export metadata tool

Change separator orienta-
tion

Ctrl + Alt + Q Change the application window layout

Find previous Shift + F3 Search specified text

Find next F3 Search specified text

SQL command history Ctrl + Shift + H Open the history of executed queries

User Manager Open User Manager

Grant Manager Open Grant Manager

Preferences Open application settings

Lower case Ctrl + Shift + L Makes the selected text lower case

About Open programme information

System console window Open the system console

Rollback all changes Ctrl + Shift + R Rollback transaction

(table breaks)

64



User Guide
C.4 SQL templates

(table breaks)

Command Shortcuts Description

Open file Ctrl + O Add selected file text to the query editor

Go to Ctrl + G Go to the specified line in the query editor

Print Ctrl + P Open the print window

Print plan Ctrl + Shift + P Show the plan of the query that is in the query
editor

Show/hide editor output Ctrl + E Show/hide the output pane in the query editor

Previous statement Ctrl + Shift + Down Insert a previously executed SQL script into the
query editor

Check for updates Check that the version of the application you are
using is up to date

Profiler Open Profiler

ER-diagram editor Open ER-diagram editor

Query Editor Open the query editor

Move up Alt + Up Move selected text one line higher

Move down Alt + Down Move the highlighted text to the line below

Next statement Ctrl + Shift + Up Insert the following saved SQL script into the
query editor

Create database Open the window of database creation

New Connection Ctrl + Shift + N Open the Create Connection window

Heap memory status Open a window with current information about the
memory status

Save Ctrl + S Save

Save As Ctrl + Shift + S Save as

Compare database meta-
data

Open the database comparison tool

Database Statistics Open the statistics tool

Trace Manager Open Trace Manager

SQL format Ctrl + Shift + F Format the selected text fragment

C.4 SQL templates
Templates simplify the writing script. After pressing the space bar, the specified abbreviation will be

converted into full text, for example: SF → SELECT * FROM.
You can add your own templates using the corresponding button.

C.5 Connection
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Table C.7 — General

Parameter Description

Startup connection Automatically connect on startup

Server connection timeout (sec) Time during which the application will try to connect to the
database. If the connection is not established before it expires, an
error will occur.

Timeout shutdown diagnostics (ms) When an error occurs from the server, Red Expert checks if the
connection is active. The parameter defines the time during which
the application will wait for a response from the server. If the timeout
is reached, the connection will be disconnected.

Connection username at opening .fdb User name, from which the connection will be made when opening
.fdb

Connection password at opening .fdb Password, with which connection will be executed when opening .fdb

Connection charset at opening .fdb Charset with which the connection will be executed when opening
.fdb

Table C.8 — Tree connection

Parameter Description

Node height Distance between nodes in pixels

Connect on double-click Connect to database after double-clicking on it in connection tree.

Sort alphabetically Sort nodes in the connection tree alphabetically

Show folders for tables Form folders for table information in the connection tree

Show system objects Show/hide system objects in the connection tree

Show connection properties panel Show/hide connection parameters panel

Show full DB statistics Display full database statistics in the connection parameters panel

Search in columns Search not only in the connection tree objects, but also in the column
names.

C.6 Editor

Table C.9 — General

Parameter Description

Auto-complete only hotkeys Suggest autocompletion only when Ctrl+Space is pressed

Auto-complete keywords on Suggest autocompletion of keywords in the query editor

Auto-complete database objects on Suggest autocompletion of database objects in the query editor

Default editor auto-commit Automatically commit changes after query execution

Recycle resultset tabs Close the previous result set when executing a query

Remove comments for execution Remove SQL comments in queries at runtime and send the query
without them to the server

Print all SQL to output panel Add the full text of the query to the output pane

Print extended query plan Add a detailed query outline to the output pane

(table breaks)
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Parameter Description

Open a new editor for new open con-
nection

Switch to a new tab of the query editor when a connection is estab-
lished

Use multiple connections Add the ability to specify multiple connections in which to execute
the query

Convert tabs to spaces Convert tabs to spaces

Tab size Number of spaces to replace the tabulation with during conversion

Limit the returned rows count Return no more strings than specified in the Maximum number of
returned strings parameter.

Maximum returned rows count Maximum number of rows that can be in the result set

Undo count Number of returns to previous states. The return command is acti-
vated by pressing Ctrl+Z (Windows).

History count The number of queries that can be stored in the history. When
the specified number is reached, old queries will be deleted from the
history

Table C.10 — Display

Parameter Description

Tools panel Display the query editor toolbar

Transaction Parameters Display transaction parameters

Status bar Show/hide status bar

Line numbers Display line numbers in the query editor

Wrap line Automatically move a line if it does not fit in the query editor.

Current line highlight Highlight in colour the line on which the cursor is located

C.7 Result set table

Table C.11 — Result set table

Parameter Description

Column resizable Enable/disable the ability to change the size of columns in the result
set

Column reordering Enable/disable the ability to drag and drop columns, swapping them
in places

Row number header Show/hide row numbers in the resulting table

Column width Column width in the resulting table

Column height Row height in the resulting table

Save column widths between queries Maintain the same column width in the resulting table

Date pattern format Date template for DATE data type. The table below describes the
template parameters in detail

(table breaks)
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Parameter Description

Time pattern format Time template for the TIME data type. The table below details the
template parameters

Timestamp pattern format Timestamp template for the TIMESTAMP data type. The table
below details the parameters of the template

Time with time zone pattern format Time template for the TIME WITH TIME ZONE data type. The
table below details the template parameters

Timestamp with time zone pattern
format

Timestamp time template for the TIMESTAMP WITH TIME ZONE
data type. The table below details the parameters of the template

Null value cell text Text to be added for NULL values

Transpose when single row result Transpose a result consisting of a single row

Align numeric values Arrangement of numeric values in a cell

Align text values Alignment of text values in a cell

Align boolean values Aligning boolean values in the cell

Align null values Aligning null values in a cell

Align other values Alignment of other types of values in the cell

Use form for adding/deleting records Open a window when adding data to the table

Use other colour for null when
adding/deleting records

Highlight a cell with a null value with a colour

Fetch size Number of records to be retrieved when opening the dataset table

Maximum records returned Maximum number of records to be returned in the resulting table

C.7.1 Datetime templates

Table C.12 — Datetime templates

Symbol Description Presenta-
tion

Examples

G era text AD; Anno Domini; A

u year year 2004; 04

y year-of-era year 2004; 04

D day-of-year number 189

M/L month-of-year number/-
text

7; 07; Jul; July; J

d day-of-month number 10

Q/q quarter-of-year number/-
text

3; 03; Q3; 3rd quarter

Y week-based-year year 1996; 96

w week-of-week-based-year number 27

W week-of-month number 4

E day-of-week text Tue; Tuesday; T

(table breaks)
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Symbol Description Presenta-
tion

Examples

e/c localized day-of-week number/-
text

2; 02; Tue; Tuesday; T

F day-of-week-in-month number 3

a am-pm-of-day text PM

B period-of-day text in the morning

h clock-hour-of-am-pm (1-12) number 12

K hour-of-am-pm (0-11) number 0

k clock-hour-of-day (1-24) number 24

H hour-of-day (0-23) number 0

m minute-of-hour number 30

s second-of-minute number 55

S fraction-of-second fraction 978

A milli-of-day number 1234

n nano-of-second number 987654321

N nano-of-day number 1234000000

O localized zone-offset offset-O GMT+8; GMT+08:00; UTC-08:00

X zone-offset 'Z' for zero offset-X Z; -08; -0830; -08:30; -083015; -
08:30:15

x zone-offset offset-x +0000; -08; -0830; -08:30; -083015;
-08:30:15

p pad next pad modi-
fier

1

' escape for text delimiter

'' single quote literal '

C.8 Tool bar

Table C.13 — Visibility

Parameter Description

Database tool bar Display/hide the database toolbar

Application tool bar Display/hide application toolbar

System tool bar Display/hide the system toolbar

The Database Tools, Application Tools, System Tools, and Editor Tools tabs contain settings for
defining the tool set of the respective panels.
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C.9 Fonts
Font settings for the query editor, connection tree, and system console fonts.

C.10 Colours
Settings for the colours that are used in the application.
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